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Equipment Required

You will need:

ProSoft's PC56-OPC or PC56-SLS

OPC Client (In this example Matrikon OPC Explorer and OPC Test Client were used)
ControlLogix Processor with a ControlLogix program downloaded to it.

ControlLogix Chassis

Computer Screen for PC56-OPC/PC56-SLS

Keyboard

Mouse

Description
Download a ControlLogix program in ControlLogix processor.

5 Who Active

[v Autobrowse |:I

= QWorkstation, KSEKI Go Online
e ]
+ E?E Linx Gateways, Ethernet Upload...
= g reorL R
= g 01, 1756-L61 LOGIX556 1, MVISEMNETR. piia Fmaian
= -Bzic<p1ane, 1756-A13/A e
é 00, 1756-L61 LOGIXS561
= Help

g 03, 1756 module, MVISE ProSoft Technology, Inc.

< é 08, 1756-ENBT/A

+ E?E Ethernet, Ethernet

Path: AB_DF1-141 Set Project Path
Path in Project.  TCP-14192.168.0.1204Backplane}0
Clear Project Path

ProSoft Technology, Inc. PC56-OPC/PC56-SLS Connection to OPC Client
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Put ControlLogix into remote run after downloading a program.

RSLogix 5000 - MVIS6MNET [1756-L61] - [Controller Tags - MVIS6MNET(col
Q Fle Edit View Search Logic Communications Tools Window Help

l%|li‘|ﬂ| Sl || I f 1Rack_19_Freezer_17:6I.[v a%l&l&l[fg: ] ' J |

=] =|

Rem Run M8 ¥ RunMode
NeEeEs ».| ¥ Controller Ok
NoEie Rk A et A [ || | i
170 Not Responding lI _I_]\ q % 7 %
= &3 Controller MVISEMNET - Scope: [E{I MVISBMNET ﬂ Show.. I MNetBackplane, MNetBIkStat, MNetEvent MNetinStat, MNettoduleDef, MNetPortErrors,
% gz::s::z:: ::ngli Handler Name & |Value €| Force Ma “IStyle |Data Type |Descrip‘ )
+ [ Power-Up Handler CmdContral 0 Decimal BOOL
= &3 Tasks ColdBoot 2#0000_0000 Binary BOOL
= £@ MairiTask |+ EventCmd oty {...} Decimal BOOL[32]
= 8 MainProgram |+ EventList Cone k| Leeel MNetEvent2]
-8 Unscheduled Programs / Phases + Last Value_from_CCLINK 0 Deciml INT
T ﬁ?ﬂi’;ggﬁ:j e | |*Locatic Gl L) AB:1756_MODU...
3 Add-On Instructions | |* Local1l {oo) {enisl) AB:1756_MODU...
= €3 Data Types * Local1:0 (onn) {ene) AB:1756_MODU...
# [ User-Defined | * MBContrall [toom iy CONTROL
+ [ Strings .| * MBControl2 {on} {ioae} CONTROL
Cp Add-Or-Lefined |+ mbdouble 0 Decimal DINT
) Predefined + MBMsg (-} {...} Decimal SINTEE00]
e ﬁeﬂggweﬁeﬁ”ed |+ MBMsgLen 0 Decimel INT
= 1 1o Configuration | MBOffset 1} Decimal INT
= 83 1756 Backplane, 1756-A13 + MBOffsetBit 0 Decimal INT
9 [0] 1756-L61 MVISEMNET v | ||_|* MBScratch oy {...} Decimal INT[3]
+ MJFAULTS ot {...} Decimal DINT[12]
+ MNetl {o.0} {...} MNethvioduleDef
+ New_Value_from_CCLINK o Decimal INT
+ test {o..} {...} Float REAL[16]
+ twodarray {...} {...} Decimal DINT[10,10]
+ twodarrayl {...} {...} Decimal DINT[1,1]
‘WarmBoot 2#0000_0000 Binary BOOL
v
£ > || XT> \Monitor Tags {Edit Tags / |« m

Ready

ProSoft Technology, Inc.
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On PC56-OPC/PC56-SLS click the Start button and choose System Management Console. (It may also
be under Start —> All Program -> ArchestrA -> System Management Console.)

Administrator

-~
Internet J My Documents
Internet Explorer :

= My Recent Documents »
&™) E-mail L-b 2 =
3 Outlook Express & 4
J My Pictures
#  System Management B My Music
/ Console =/

] My Computer
\3 M3 33

D? Control Panel
:'3 Windows Messenger

@ Set Program Access and
Defaults

@ MatrikonOPC Explarer i .?j Printers and Faxes

{ @ Tour Windows XP t_)) Help and Support

b | Files and Settings Transfer /.) Search
Wizard

all Programs D

Log OFff @ Shut Down

Create/Modify/Add Logix5000_PC56 Object to meet your application.

7 SMC - [ArchestrA System Management Console (PC56-D378463393)\DAServer Manager\Default Group\Local\ArchestrA.PC56SLSOPC. 1\Configuration\New. BACKPLANE_PC56_000\]
File Action View Help
e @@ X 2
ﬂ Archestra System Management Console (PCS6-D3784633
=[] paserver Manager
=) Default Group

= & Local PCS6_000 Parameters | Device Groups | Device Items |
= ‘3 Archestra PCSE6SLSOPC.1

= /4 Configuration

7! Node Type: LOGIX5000_PC56 Delimiter: .

= 4, New_BACKPLANE_PCS6_000 _
A Processor Type: LOGIX5000
+[5] Log Viewer
Slot Number: o

Local Backplane: (&

Reply Timeout: 5000 MSec.

PC56 - Remate Communications Path

Slot Number:
Reply Timeout: MSec.
Remote Slot Number:

ControlNet Network: ControlNet Node No.:
Ethemet Network: IP Address: 1

Refresh Tag View View All Tags |

ProSoft Technology, Inc. PC56-OPC/PC56-SLS Connection to OPC Client
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Right click on ArchestrA.PC56SLSOPC.1 and choose Activate Server.

File Action View Help

« OmB 2 B

(& Archestra System Management Console (PCS6-D3784633 | Companent Version | Build Date
=& DAServer Manager [Tpcsesisorc 0001.0001.0001.0010 January 23, 2007
=8 [;ffa”'t Group [TlPcsestsorc [Shel] 0689.0039,0038.0002 November 3, 2006
=-Bl ‘L.“a' [ original DAS Toolkit 0689.0000.0038.0000 March 28, 2005
= ‘?' Deactivate Server iEngine 0809.0438,0000.0000 February 21, 2008
% [£] Diagnostics Configure As Service » INOPC 0809.0216,0000.0000 February 21, 2008
5 [ LogViewer InDDESL 0809.0216,0000.0000 February 21, 2008
View »
Export List...
Help
< | &

untitled - Paint.

NE_PC56_000\]

File Action View Help
® - m X 2

(5 Archestra System Management Console (PC56-D3784633

=[] paserver Manager
- %) Default Group
=8 Local PCS6_000 Parameters | Device Groups I Device Items l
= \3 ArchestrA, PCS6SLSOPC. 1
= /4 configuration
= 4 New_BACKPLANE_PCS6_000 ” "
/g PCS6_000 Export to file | Close View |
* Diagnostics
+ [ Log Viewer | Tag | DataType [Bytes  [®Dim  [YDim  [2Dim |
CmdControl Bool 1 0 0 0
ColdBoot Bool 1 0 0 0
EventCmd Dint 4 1 0 a
EventList Address Int 2 ) 0 0
EventList Count Int 2 0 0 0
EventList DBAddress  Int 2 a 0 a
EventList Function Int 2 ) 0 0
EventList|PO Int 2 0 0 0
EventListIP1 Int 2 a 1} a
EventListIP2 Int 2 ) 0 0
EventList|P3 Int 2 0 0 0
EventList Node Int 2 a 0 a
EventList ServPort Int 2 ) 0 0
EventList Swap Int 2 0 1] 0
Last_Value_from_CC... Int 2 0 0 0
11:.C.Data Sint 1 400 0 0
Int Z 250 0 0
Int 2 248 0 1}
1 Dint 4 13 0 0
MBControl1.CTL Dint 4 0 0 0
MBControll.DN Bool 1 a 0 a
MBControll EM Bool 1 ) 0 0
MRPantnll FN Reol 1 n n n ¥
< | B

Control Panel

MatrikonOPC Explorer

PC56-OPC/PC56-SLS Connection to OPC Client
Page 6 of 24
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You should see Topic_0 in the name column and 1000 under Update Interval on the Device Groups tab.

‘File Action  View Help
e = | % @
(5 Archestra System Managsment Console (PCS6-D3784633

= DAServer Manager
-1 %) Default Group

Node Type: LOGIX5000_PC56 Del

= 5] Local PCS6_000 Parameters Device Groups | Device Ttems |
= [ Archestra.PCS65LSOPC.1
= /4 Configuration - Name | Update Interval (ms)
= /4 New_BACKPLANE_PCS6_000 Topic_0 1000
/& PCs6_000

ol Diagnostics
+ [ Log Viewer

A
I~

** |ocal Disk (C

File Edit View Favorites Tools Help

@Back A | t’ /j)Seavch || Folders v

Address [<e C:\

System Tasks | Documents and Settings ‘I"//

[/ Hide the contents of
@ this drive

) Addor remove | Program Fies | I// Prosoft

programs

5 search for files or
folders

Samples

File and Folder Tasks A

=i} Rename this fie | wmpows e
0O
[y Move this file pen
7 B . Print
Q) crykiie :css-q-anu | Open With...
ext Document Forma ...

&) Pubiish this file to the 4KB
Web

(2] Compressed (zipped) Folder
() E-mail this file cut (@ Deskrop (create shortcut)
\
i3y Print this file Copy __J Mail Recipient
¥ Delete this file i
Create Shortcut U My Documents
-
Other Places S i

% My Computer Properties

() My Documents
| Shared Documents
&3 My Network Places

‘s Start % SMC - [Archestra MatrikonOPC Explorer & PCS6-OPC_PCS6-5LS... = Local Disk (C:) i PCS6-OPCE

ProSoft Technology, Inc. PC56-OPC/PC56-SLS Connection to OPC Client
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Open the PC56-0-5000.csv file using Excel on a computer with Microsoft Excel.

B3 Microsoft Excel - PC56-0-5000
i) Fle Edt View Insert Format Tools Data  Window Help

NEEHRSSRITEBI B 0o 8 s mse B

Al X f Tag
= e [ o B R el R T R M N [ er R [ oy
|1 |Tag # cut pe Bytes XDim YDim ZDim
2 _|CmdControl > 1 0 0 0
3 [ColdBoot AR 1 0 0 0
4 |EventCrnd 3] Paste 4 1 0 0
| 5 |EventList. Address Paste Special... 2 0 0 a
6 _|EventList. Count ] 2 o 1) o
7 |EventList DBAddress Tnseit 2 0 0 0
| 8 |EventList.Function Delete 2 0 0 0
L9 [EventList.IPO Clear Contents 2 0 0 0
|10 |EventList.IP1 ——— 2 0 0 0
L1 |EventList.IP2 CSfy Format Cels... 2 0 0 0
| 12 |EventList.IP3 Column Width... 2 0 0 0
| 13 |EventList. Node Hide 2 o 0 a
| 14 |EventList. ServPort = 2 o 1) o
|15 |EventList.Swap Unhide 2 1] 0 1]
| 16 [Last_Value_from_CCLINK Int 2 a 1) a
|17 |Local:1:C.Data Sint 1 400 0 0
| 18 |Local:1:].Data Int 2 280 o o
| 19 |Local:1:0.Data Int 2 248 o 0
| 20 |MBCoil. Boolean Dint 4 13 0 a
| 21 |MBControl1.CTL Dint 4 0 1) 0
| 22 |MBControl1.DN Bool 1 o 1) o
| 23 [MBContrall. EM Bool 1 o 1) o
| 24 [MBContral1.EN Bool 1 o 1) o
| 25 |MBContrall.ER Bool 1 o 1) o
| 26 [MBControl1.EU Bool 1 0 0 0
| 27 |MEControll.FD Bool 1 o o o
| 28 [MEControl1.IN Bool 1 o 1] o
| 29 |MBControl1 LEN Dint 4 a 0 a
| 30 |MBControl.POS Dint 4 0 1) o
| 31 |MBControl1.UL Bool 1 o 1) o
| 32 |[MBControl2.CTL Dint 4 0 0 0
| 33 |MBControl2.DN Bool 1 o 1) o
| 34 [MBControl2. EM Bool 1 0 ] 0
| 35 [MBEContral2. EN Bool 1 0 o 0
| 36 [MBControl2.ER Bool 1 o 1] o
| 37 |MBControl2. EU Bool 1 0 0 a
| 38 |MBControl2.FD Bool 1 o 1) o
| 39 |MBControl2.IN Bool 1 o 1) o
| 40 [MBControl2.LEN Dint 4 0 0 0
| 41 |MBControl2. POS Dint 4 0 0 0
| 42 IMBControl2.UL Bool 1 0 0 0
| 43 [mbdouble Dint 4 0 ] 0
| 44 [MBMsgy Sint 1 500 i] 0
| 45 [MBMsglen Int 2 o 1) o
|46 |MBOffset Int 2 0 0 0
| 47 |MBOffsetBit Int 2 0 0 0
| 48 [MBScratch Int 2 3 1) o
| 49 [MJFAULTS Dint 4 12 0 0
A IMNet1 RP Rlnckindpy Int 2 n n n <
W < » »\PC56-0-5000 / < | >

Ready

PCS6-OPC7 - Paint.

ProSoft Technology, Inc. PC56-OPC/PC56-SLS Connection to OPC Client
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Copy column A then paste it in Column B. Delete Column C, D, E and F.

icrosoft Excel - PC56-0-5000
._:Z_l] File Edit View Insert Format Tools Data Window Help

NERRSSRTEI 8B B S0 8 F A2 RS0  Hime

B8 % o %%

C1 > &

A [ B 6 [ H ] | I ) [ [ ) [ )

| 1 |Tag Tag
| 2 |CmdControl CmdControl
| 3 |ColdBoot ColdBoot
| 4 |EventCmd EventCmd
| 5 |EventList. Address EventList Address
| B |EventList.Count EventList.Count
| 7 |EventList. DBAddress EventList. DBAddress
| 8 |EventList.Function EventList.Function
| 9 |EventList.IPO EventList.IPO
| 10 |EventList.IP1 EventList.IP1
| 11 |EventList.IP2 EventList.|P2
| 12 |EventList.IP3 EventList.IP3
| 13 |EventList. Node EventList.Node
| 14 |EventList. ServPort EventList. ServPort
| 15 |EventList. Swap EventList. Swap
| 16 |Last_Value_from_CCLINK Last_Value_from_CCLINK
| 17 |Local:1:C.Data Local:1:C.Data
| 18 |Local:1:].Data Local:1:1.Data
| 19 |Local:1:0.Data Local:1:0.Data
| 20 |MBCoil. Boolean MBCoil. Boolean
| 21 |MBControl1.CTL MBControl1.CTL
| 22 |MBControl1.DN MBCaontrol1.DN
| 23 |MBControll. EM MBControl1.EM
| 24 |MBControl1.EN MEBCantrol1.EN
| 25 |MBControl1.ER MECantrol1.ER
| 26 |MEBControll.EU MECantrol1.EU
| 27 |MEControll.FD MECantrol1.FD
| 28 [MBCaontrol1.IN MBCantrol1.IN
| 29 |MBControl1.LEN MBControl1. LEN
| 30 |MBControll.POS MBControl1.POS
| 31 |MBContrall.UL MBControl1.UL
| 32 |MBControl2.CTL MEBControl2.CTL
| 33 |MBControl2.DN MEBCantrol2.DN
| 34 |MEControl2. EM MEBCantrol2. EM
| 35 |MBControl2. EN MBControl2. EN
| 36 |MEControl2.ER MECantrol2. ER
| 37 |MBControl2. EU MBControl2. EU
| 38 |MBControl2.FD MBControl2.FD
| 39 |MBControl2.IN MBCaontrol2.IN
| 40 |MBControl2. LEN MBControl2.LEN
| 41 |MBControl2.POS MBCantrol2. POS
| 42 |MBControl2.UL MECantrol2. UL
| 43 |mbdouble mbdouble
| 44 [MEBMsg MBMsg
| 45 |MBMsglen MBMsglen
| 46 |MBOffset MBOffset
| 47 |MBOffsetBit MBOffsetBit
| 48 [MBScratch MBScratch
| 49 |MJFAULTS MJFAULTS

A [MNet1 RP Rlnckindex MNet1 BP Blnckindex A
W < » »\PC56-0-5000 / < >
Ready UM

=

"= Local Disk (C:)

SMC - [Archestr, MatrikonOPC Explorer PCS6-OPCS - Paint.

Save the Excel file back onto the USB memory stick.

Copy the Excel file on the C drive of the PC56-OPC/PC56-SLS.

PC56-OPC/PC56-SLS Connection to OPC Client
Page 9 of 24
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Right click on the Device Items tab on PC56-OPC/PC56-SLS then click import.

% SMC - [ArchestrA System Management Console (PC56-D378463393)\DAServer Manager\Default Group\L.ocal\ArchestrA.PC56SLSOPC. 1\Configuration\New_BACKPLANE_PC56_000\]
File View Help
&=+ Am X @
(& ArchestrA System Management Console (PCS6-D3764633
= DAServer Manager

= @ Default Group

== Local
= a Archestrd.PCSESLSOPC. 1
= 4 Configuration
= /4 New_BACKPLANE_PCS6_000

Action

7! Node Type: LOGIX5000_PC56

Delimiter: .

PCS6_000 Parameters | Device Groups  Device Items |

Name | Item Reference

/& Pcse_noo
+ [1] Diagnostics o
= [g] Log Viewer .
=) Default Group
= Local
() Opened Log Files

MatrikonOPC Explorer

Go to C: drive and choose the PC56-0-5000.csv file then click Open. Click on the disk icon at the right
corner to save on the Device Items tab.

(5 Archestr System Management Console (PCS6-D3784633
= DAServer Manager
=) Default Group
= 5 Local
= a ArchestrA, PCSESLSOPC. 1
= /4 configuration
= 4 New_BACKPLANE_PCS6_000
A pCss_ooo

+ Diagnostics

+[5] Log Viewer

7Y  Node Type: LOGIX5000_PC56 Delimiter: .

PCS6_000 Parameters I Device Groups  Device Items

Name Item Reference

Lookiin: | g Local Disk (C:) =] ek B
! |Z)Documents and Settings
L.é (Emisc
My Recent \Z)Program Files
Documents | )Prosoft
9 ()5amples
Desktop
My Documents
My Computer
.. File name: [Pcss.05000 ~| Open
My Network  Files of type: |CsV Files (“.csv) ~| Cancel
Places

™ DOpen as read-only

["= Local Disk {C)

iy start

MatrikonOPC Explorer & FCS6-OPC_PCS6-5LS... \C56-OPCY - Paint B3 Microsoft Excel - PCS... 10:00 PM

PC56-OPC/PC56-SLS Connection to OPC Client
Page 10 of 24
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Right click on ArchestrA.PC56SLSOPC.1 and choose deactivate server.

7 SMC - [ArchestrA System Management Console (PC56-D378463393)\DAServer Manager\Default Group\.ocal\ArchestrA.PC56SLSOPC.1]

File Action View Help

¢+ AEB @ B

ﬂ ArchestrA System Management Console (PCS6-D3784633 | Component Yersion ! Build Date.
- [ DAserver Manager [T]pcsesLsopc 0001,0001.0001,0010 January 23, 2007
=& Default Group [l PCsesLsoRC [Shell] 0689.0039,0038,0002 November 3, 2006
=B Local [ original DAS Toolkit 0689.0000,0038.0000 March 28, 2005
=@ AUERE: Deactivate Server Engine 0809,0438.0000.0000 February 21, 2008
i A E;’:f;'{?:f” Configure As Service » [INOPC 0809.0216,0000.0000 February 21, 2008
- NDDESL 0809,0216,0000.0000 February 21, 2008
+ [&] Log Viewer View »
Export List...
Help

A
|»

MatrikonOPC Explorer | @ PCS6-OPC_PCS6-5L5... | B Control Panel [ untitled - Paint

In this example Matrikon OPC Explorer is downloaded on the PC56-OPC/PC56-SLS module. This was
done to simplify the connection configuration between Matrikon OPC Explorer and PC56-OPC/PC56-
SLS. You will need additional configuration if you were connecting to PC56-OPC/PC56-SLS from a
remote device.

Matrikon OPC Explorer can be downloaded at:
http://www.matrikonopc.com/products/opc-desktop-tools/opc-explorer.aspx

This link may be updated periodically, so if the link does not work please check http://www.matrikon.com
for additional information.

Open Matrikon OPC Explorer.

File Action View Help
& @ X 2
(@ Archestra System Management Console (PCS6-D3784633

=[] paserver Manager
-1 %) Default Group

7Y  Node Type: LOGIX5000_PC56 Delimiter: .

=Bl Local PCS6_000 Parameters Device Groups | Device Ttems |
=3 Archestra PCSESLSOPC.1
A C/onfiguration Name Update Interval (ms)
= /4 New_BACKPLANE_PCS6_000 Topic.0 1000
/& PCs6_000
= [g] Log Viewer
- %) Default Group
Local

() Opened Log Files

@ set Program Access and Defaults
%% Windows Catalog
% windows Update

Administrator

- IT) Accessories
Internet
Internet Explorer 1) Archestra
o »
5 E-mail ) Games

d Outlook Express

i MatrikonOPC

%’ System Management I Microsoft Office
Console & prosott

) Analyzer »

I Simulation > MatrikonOPC Explorer
Files and Settings Tra () Startup

3 Wizar

@) Wonderware
@ MatrikonOPC Explorg Adobe Reader 9

@ Internet Explorer

‘3 o w0 msh

2
A‘}% Windows Messenger ) Outlook Express
. Remote Assistance

@ Tour Windows ¥p || & Windows Media Player
3 Windows Messenger

QUL ) windows Movie Maker

Log OFF @ Shut Down

i start ["# smc - [archestra Sys. .. o % 305PM

ProSoft Technology, Inc. PC56-OPC/PC56-SLS Connection to OPC Client
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Right click on the Add/Connect Server.

7 MatrikonOPC Explorer - [Untitled*]

Document Code: TN2009_PC56_OPCClient

File Server Group Item View Help
L3 T B
Localhost {\PCS6-D378463393'
" lhost "{{PCS6-D a
] Addjcomect Server |
S Matrikon,OPC. Simulation. 1
+I &b Network Neighborhood
) Other Network Computers

@ Matrikon0

‘OPC Server Connection Options

7
/)
J/

Add Tags

MatrikonOPC Configuration Options

Server Status

Server Info

Avoid mission-critical system failure!

Supported OPC Interfaces

[ DA WD GRS ERSED ¢

OPC Security

@ OPC SECURITY CHECK

Caution: Potential Security Risk Detected.

Explanation: This OPC Server does not support
the OPC Security Specification.

Solution: If security is a concern then
protect your existing OPC Server with the
MatrikonOPC Security Gateway.

For more information on the MatrikonOPC
Security Gateway Click Here,

Group Info

with A&E functionality
y

PCS6-OPC12 - Pai

Click OK.
@ trikonOPC Explorer

[Untitled*]

&

Localhost {\PCS6-D378463393"

Connecting to an OPC Server

‘OPC Server Connection Options

)/

Add Tags

=

MatrikonOPC Configuration Options

Server

The combo box below contains a list of OPC
Servers that are currently browsed.

c |

& Server Status
g |ArcheserPESBSLSDF‘C.1

=l

Server Info

WORKSHOPS & CERTIFICATION

Supported OPC Interfaces

[ DA WD GRS ENSEO ¢

OPC Security

® OPC SECURITY CHECK

Caution: Potential Security Risk Detected.

Explanation: This OPC Server does not support
the OPC Security Specification.

Solution: If security is a concern then
protect your existing OPC Server with the
MatrikonOPC Security Gateway.

information on the MatrikonOPC
ewa

Group Info

practical OPC hands-on training that
gets you certified

® MatrikonOPC
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File Server Group Item View Help
RAEEH| e
Archestra, PCSESLSOPC. 1
= 'y Localhost "PCSt
hestr .1
O Matrikon.OPC. Simulation. 1
+I &b Network Neighborhood

) Other Network Computers

OPC Server Connection Options

¥ o)

Disconnect

MatrikonOPC Configuration Options

Server Status

Server: ArchestrA.PCS6SLSOPC. 1

Connected: Yes
State: Running
Groups: 0
Total Items: 0
Current Local Ti
Update Local
Bandwidth Usage: 42

Server Info
Server: ArchestrA,PCS65LS0PC.1

Connected: Yes

State: Running

Groups: 0

Total Items: 0

ICurrent Local Time: 12/12/2007 3:11:52.052 PM
Update Local Time: 12122007 3:07:56.834 PM
Bandwidth Usage: 42

@ MatrikonOPC

Add Tags

Supported OPC Interfaces

[ DA WD GRS ERSED ¢

OPC Security

® OPC SECURITY CHECK

Caution: Potential Security Risk Detected.

Explanation: This OPC Server does not support
the OPC Security Specification.

Solution: If security is a concern then
protect your existing OPC Server with the
MatrikonOPC Security Gateway.

For more information on the MatrikonOPC
Security Gateway Here,

: 12/12/2007 3:11:52.052 PM
: 12/12}2007 3:07:

56,834 PM

Group Info

Secure Your
OPC Data Now.

Security Gateway

Download Now!
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TECHNOLOGY

Expand New_BACKPLANE_PC56_000 by clicking the plus sign at the New_BACKPLANE_PC56_000
branch, which will then show PC56_000.

File Action View Help

& m X 2

(5 Archestr System Management Console (PCS6-D3784633
= DAServer Manager
=) Default Group

=5 Local
= [ Avchestra.PCS6SLSOPC. 1

= /4 Configuration
= 4 New_BACKPLANE_PCS6_000
A pCss_ooo
* Diagnostics
= [g] Log Viewer
=) Default Group

- [&]x]

7Y  Node Type: LOGIX5000_PCS6 Delimiter: .

PCS6_000 Parameters Device Groups | Device Items ]

MName Update Interval {ms)
Topic_0 1000

e MatrikonOPC Explorer (Topic_0)

5 Local File Edt View Browse
() Opened Log Files 5 - o s
¥ X = 1
o Enkry ] Tags to be added:

‘@ Item ID: @
DataType: |Empry/Default v| W Create Active
Access Path: B

Eilter: Data Type Filter: |Empty/Defaut v

v Write Access v Read Access | Branches | Items

Available Ttems in Server "ArchestrA,PCSESLSOPC. 1"
= New_BACKPLANE_PCS6_000
a B |

S

15 Available Tags
5 §5YSActiveltemCount
%5 §5YS$EnableState
5 $5YS$ErrorCode

5 $5YS$ErrorCount &
[ o

Click on a grouping to view the Items it contains

¥ ; r [}
iy Start % SMC - [Atchestrd Sys... 1§ PC56-OPCIS - Paint

ProSoft Technology, Inc. PC56-OPC/PC56-SLS Connection to OPC Client
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TECHNOLOGY

From the Available Tags list, choose a tag for Matrikon OPC Explorer to interrogate from the PC56-
OPC/PC56-SLS. (In this example the WarmBoot tag was double-clicked.)

File Action View Help
e @B X B

(5 ArchestrA System Management Console (PC56-D3784633

7Y  Node Type: LOGIX5000_PCS6 Delimiter: . "y

= DAServer Manager
=) Default Group
=B Local PCS6_000 Parameters Device Groups | Device Items |
= [ ArchestrA PCSESLSOPC.1
= 4 Configuration Name Update Interval {ms)
= 4 New_BACKPLANE_PCS6_000 Topic_0 1000
A pCss_ooo
* Diagnostics
= [g] Log Viewer
=) Default Group
= Local File Edt View Browse
) Opened Log Files o 5
= ? M X @ g =
Tag Entry ] Tags to be added:
‘uﬁé
T8 pemm: £
I New_BACKPLANE_PCS6_000.PCS6_ 5, e BACKP...
DataType: |Empry/Default v| W Create Active
Bt [ &
Access Patl d}
Eilter: Data Type Filter: |Empty/Defaut v
v Write Access v Read Access | Branches | Items
Available Items in Server 'ArchestrA PCS65LSOPC. 1"
=[] New_BACKPLANE_PC56_000
23 PCS6_000 S| |
15 Available Tags »
s test
T bwodarray
5 bwodarray 1
i v
oK Cancel
Total number of available tags in this view is 111, Right click for more options. 4
S ¥

¥ ; r [}
iy Start % SMC - [Atchestrd Sys... 1§ PC56-OPC16 - Paint

ProSoft Technology, Inc. PC56-OPC/PC56-SLS Connection to OPC Client
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Right click on the Tag you have created in the T
OK.

System Mz

Document Code: TN2009_PC56_OPCClient

ags to be added: area. Click Validate Tag, and then click

File
&

Action  View Help
| X 2
(5 Archestr System Management Console (PCS6-D3784633
= DAServer Manager

=) Default Group

== Local

= |4 Archestra PCS65LSOPC. 1

7Y  Node Type: LOGIX5000_PCS6

PCS6_000 Parameters Device Groups | Device Itel

Delimiter: .

ms |

File Edt View Browse
¥ 8 X@ g =4

Tag Entry ]

() Opened Log Files

= 4 Configuration Name Update Interval {ms)
= 4 New_BACKPLANE_PCS6_000 Topic_0 1000
A pCss_ooo
* Diagnostics
= [g] Log Viewer >
=) Default Group e MatrikonOPC Explorer (Topic_0)
= Local

Tags to be added:

Tasy Item ID: |new_BACKPLANE_PCS6_000.PCS6. B Edit
8 1 vaidote e
DataType: |Empry/Default v| W Create Active Remove Del
Access Path: % View »
Eilter: Data Type Filter: |Empty/Defaut v
v Write Access v Read Access | Branches | Items
Available Items in Server 'ArchestrA PCS65LSOPC. 1"
=[] New_BACKPLANE_PC56_000
23 PCS6_000 | |
Tag: New_BACKPLANE_PCS6_000.PCS6_000.War
Access Path:
validated: No
Data Type: Empty/Default

15 Available Tags o] Create Active: Yes
s test
= " Readable: 777
(Ebtodarray, Writeable: 777
5 bwodarray 1
T WarmBook =

v

oK Cancel
< L1
L 4 ; r [}
4 Start %' SMC - [Archestrd Sys... | \§ PCS6-OPCL7 - Paint MatrikonOPC Expl

lorer

L

%
v

314 PM

You have created a tag on Matrikon OPC Explorer.

7%, MatrikonOPC Explorer - [Untitled*]
File Server Group Item View Help

iy
=

Topic_0

b X

Contents of 'Topic_0'

EEX

= 4 Localhost "{|PCS6-D378463393'
= o ArchestrA,PCS65LS0PC. 1
4 Topic_0
O Matrikon,OPC, Simulation, 1
+I &b Network Neighborhood
) Other Network Computers

Item ID
w_BACKPLANE ...

Server Info

Access Path | Value ualit Timestar

12{12/200...

Status

Active

Good, non-specific

Group Info

| WORKSHOPS & CERTIFICATION
practical OPC hands-on training that
gets you certified

Server: Archestra,PCS65LS0PC. 1 Group: Topic_0
Connected: Yes

State: Running

Groups: 1

Total Items: 1

ICurrent Local Time: 12/12{2007 3:15:23.316 PM
Update Local Time: 12/12/2007 3:15:12.110 PM
Bandwidth Usage: 42

—_——— -
1y Start % SMC - [Atchestrd Sys...

[\ Pcse-opC18 - Paint

Connected (Async I/0): Yes (2.0)

Active: Yes
Items: 1

Current Update Rate: 1000 ms
Percent Deadband: 0.00%

31SPM
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PC56-OPC/PC56-SLS Connection to OPC Client
Page 16 of 24



Technical Note

Document Code: TN2009_PC56_OPCClient

Testing Using OPC Test Client (Remotely)
Click on Start menu —> All Programs —> Rockwell Software —> RSLinx —> Tools -> OPC Test Client.

7RSI - OPC Test Client g@@

File Server View Help

D] =[5 |

Ready [ hom[

Go to the menu bar and click File —> New. Click Browse... .

Select an OPC Server.

OPC Saner Prog 1D oK
|HiIschaerbH.CifOpc:Server

Cancel
Located Servers:

HilscherGmbH.CifOpcServer
Matrikan.OPC.Simulation
Matrikan.OPC.Simulation.”
RSLing OPC Server

RSLin Remote OPC Server

Browse...

I

Node Name (Optional):

ProSoft Technology, Inc. PC56-OPC/PC56-SLS Connection to OPC Client
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At Node type the IP address of the PC56-OPC, then click Connect.

Enumerate OPC Servers @
NoS I

|1 01.2.75 Connect Cancel

(@ 1.0a OPC Servers (— 2.0 0PC Servers

HilscterGmbH.CtOpcserver.]
Matrikon. OPC.Simulation 1
RSLinx OPC Senver

RSLinx Remote OPC Server

Choose the 2.0 OPC Servers. Highlight ArchestrA.PC56SLSOPC.1 then click Select.

Enumerate OPC Servers @

Node: 41
|1 01.2.75 Connect Cancel

(" 1.0a OPC Servers (@ 2.00PC Senrvers

ArchestrA PChhsLS0RC]
RSLinx OPC Server
RSLinx Remote OPC Server

Click OK.

Select an OPC Server @

OPC Saneer Prog 1N oK
IArchestrAPCEBSLSOPC.1

Cancel

Located Servers:
HilscherGmbH.CifOpcSerser

Browse...

Ul

Matrikon. OPC.Simulation

Matrikon. OPC.Simulation.”
RSLing OPC Senver
RSLing Remote OPC Server

Node Name (Optional):
[10.1.2.75

ProSoft Technology, Inc. PC56-OPC/PC56-SLS Connection to OPC Client
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Go to the menu bar and click Group —> Add Group.

% RSl - OPC Test Client - [10.1.2.75~ArchestrA. PC56SLSOPC. 1]

gf File Server Group Item Log View Window Hep

D B

ItenID [subvaue  [SubQuaity [SubUpdates |UpdateRate [Rum.Avg |

Ready NUM

Type in the appropriate Group Name, then click OK.

Add New Group @

Group Name: W Cancel
Update Rate (mSec): ]1000
[V Active
Time Bias: [U— [ Update Rate
% Deadband: ’1— [v Allow Timeout

Advise: |ICannectionPaint (Rev 2.0) |
I

ProSoft Technology, Inc. PC56-OPC/PC56-SLS Connection to OPC Client
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Go to the menu bar and click Item —> Add ltem.

Add New OPC Item @

ltems 0 be Added Attributes
Access Path: l
Canczl

ltem Name: |

Add lterm
Active:  [v
Datatype: |T_EMPTY |
E Heiiroperies |
Datatype: |Native v v Filter: | Access:  |All ltems =

+ ArchestrA PCS6SLSOPC. 1 (Node: 10.1.2.75) Archest-A.PCSESLSOPC. 1 (Mode: 10.1.2.75) | A

3SYS$ACtiveltemCount

$SYS$EnableState

$SYS$ETorCode

$SYS$ETorCount

$SYSYETOrText

$SYS4ItemCount

$SYS4Licensed

$SYS$Vaxinterval

$SYSIPolNow

$SYS$ReadComplete ¥

You can add items using this dialog. Click on validate items if vou wist to check your items against the server before
addingthem. Results will be displayed from this action.

ProSoft Technology, Inc. PC56-OPC/PC56-SLS Connection to OPC Client
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Open the ArchestrA.PC56SLSOPC.1 (Node: 10.1.2.75) branch, then open the
New_BACKPLANE_PC56_000 branch. Highlight New_LOGIX5000_PC56_000.

Add New OPC Item @

ltems 0 be Added Attributes
—_—
Access Path: l
Canczl

tem Name: [ M

Active:  [v
Datatype: |yT_EMPTY = —]
3 [

Datatype: m il Filter: {* Access:  |Allltems =
- ArchestrA PCS6SLSOPC. 1 (Node: 10.1.2.75) ArchestA.PCSESLSOPC. 1 (Node: 10.1.2.75)\New _
--New_BACKPLANE_PCS&_000 timer_28
timer_23
timer_3D
timer_31
timer_32
twodarray
twodarray 1
WarmBoot
v
< >

You can add items using this dialog. Click on validate items if vou wist to check your items against the server before
addingthem. Results will be displayed from this action.

ProSoft Technology, Inc. PC56-OPC/PC56-SLS Connection to OPC Client
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You'll need to type in the path and the item name in the Item Name: parameter, e.g.
New_ BACKPLANE_PC56_000.New_LOGIX5000_PC56_000.WarmBoot.

Click on Validate to check for the validity of the tag.

Add New OPC Item @

Attributes

ltems 0 be Added

New_BACKPLANE_PCEE_000.New_

Access Path: l

Canczl

Add ltem

tem Name: 0n_pCs6_000.warmBao;

Active:  [v
Datatype: |VT_EMPW LI Validate
[~

Item Properties

Datatype: |Native v v Filter: |* Access:  |Allltems ¥
- ArchestrA PCS6SLSOPC. 1 (Node: 10.1.2.75) ArchestA.PCSESLSOPC. 1 (Node: 10.1.2.75)\New _
- New_BACKPLANE_PCS&_000 timer_28
New_LOGIX5000_PC56_000 timer_23
timer_30
timer_31
timer_32
twodarray
twodarray 1
WarmBoot
v
< >

You can add items using this dialog. Click on validate items if vou wist to check your items against the server before
addingthem. Results will be displayed from this action.

Click OK when you see the tag is valid.

Validation Results @

| Access Rights I Blob Size l
Read / Write 0

ltem Name
New_BACKPLAN...

I Server Handle I Data Type
nooooooo Boolean

PC56-OPC/PC56-SLS Connection to OPC Client
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Then Click OK on this window.

Add New OPC Item @

ltems -0 be Added Attributes
New_BACKPLANE_PCEE_000.New._ OK

Access Path: l m—
ancz
tem Name: 0n_pCs6_000:warmBaot
Add ltem
v

Active:

Datatype: [\T_EMPTY |

r Item Properties

Datatype: |Native v v Filter: | Access:  |Allltems =
- ArchestrA PCS6SLSOPC. 1 (Node: 10.1.2.75) Archest-A.PCSESLSOPC. 1 (Node: 10.1.2.75)\New_f ~
- New_BACKPLANE_PCS&_000 timer_28
New_LOGIX5000_PC56_000 timer_23
timer_30
timer_31
timer_32
twodarray
twodarray 1
WarmBoot
v
< ‘ >

You can add items using this dialog. Click on validate items if vou wist to check your items against the server before
addingthem. Results will be displayed from this action.

You have created a tag with OPC Test Client. Repeat this procedure for all other tags you want to test
using OPC Test Client.

% RSl - OPC Test Client - [10.1.2.75-ArchestrA.PC56SLSOPC.1]

E’ File Server Group Item Log View Window Hep o & x
NEEEE
[ Topic_O (Actual Rate: 1000) ItenID |subvaue | subQuaity | SubUpdates | Update Rate | Run. Avc
@ New_BACKPLANE_PCSA_000. New_LOGIXS000_PCSE_N00. WarmBaot Off Gand 1 0 0.40749¢
< >
Ready NUM
ProSoft Technology, Inc. PC56-OPC/PC56-SLS Connection to OPC Client
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Conclusion

In this document you learned how to interrogate a tag from a ControlLogix processor to ProSoft's
PC56-OPC/PC56-SLS modules to Matrikon OPC Explorer to OPC Test Client. If you need additional

information, please contact us.
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